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GETTING YOUR CLIENT STARTED 

As ProAdvisors, one of the most marketable services we can promote is that of setting clients up on 
QuickBooks. When the client company is a new business, it is all very straightforward, and we can 
start entering all transactions and names as we need them, as they occur. Everything starts at zero. 

More often than not, however, the enterprise is one that has been in existence for some time and we 
are not going to enter all transactions going back to the beginning of time for this entity. Chances are 
that the company had been using some method of tracking their accounting transactions, whether it's 
another accounting software package, a spreadsheet, or a manual system that has served them until 
now. Perhaps they are using a combination of systems cobbled together. 

QuickBooks is simple enough to use so that the client could start posting transactions such as 
cheques and invoices almost immediately. However, in existing companies in which QuickBooks is 
just being implemented, none of the resulting financial statements or reports (such as Balance Sheet, 
Profit & Loss, Accounts Receivable and Accounts Payable reports) will be correct, because none of 
the old information has been brought into the new QuickBooks data file. 

Since it is usually not feasible to go back to the beginning of a company’s life and enter every 
transaction from “day one,” it is most prudent to choose a conversion or Start date at which to begin 
using QuickBooks with the company data file properly populated with correct information (list names, 
balances, etc.) as if QuickBooks had been used since the beginning of time.  

Essentially, a QuickBooks company data file is composed of lists (chart of accounts, customer list, 
supplier list, items, etc.), transactions (with amounts and balances), and reports (such as the Balance 
Sheet). To bring these lists and historical account balances from the old system previously used into 
QuickBooks, you need a methodical step-by-step plan. Follow these basic steps to convert your 
clients.  

The following list categorises the steps as either Must Do (immediate), Should Do (eventually), or 
Nice to Do (if you’re advanced and you can do it). The list includes steps that may not apply to 
every type of company. Nevertheless, you will find your situation covered among these steps (and 
detailed instructions follow in the Appendices). 
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MUST DO: DECIDE ON A START DATE 
On which date to begin using QuickBooks for recording daily transactions.  

 For new companies, this is easy: select the day before any transactions would take place 

 For existing companies, you have some considerations to take into account because you have 
options 

o Ideally, the Start Date should be a financial year-end. Therefore, it would be best to start 
preparing for the conversion before the year-end date so that the live transactions can be 
entered only once, into QuickBooks, rather than entered twice (into an old system and 
then re-entered into QuickBooks. If you have to start at the last financial year-end, and it 
was 10 months ago, that would mean 10 months of transactions to re-enter. In that case, 
it might be best to wait the additional two months and convert at that point.) Most of this 
guide will focus mainly on the year-end Start Date. Remember that the Start Date should 
be the last day of the prior financial period, not the first day of the new financial period. 
You don't want live current year transactions to distort the trial balance from the previous 
year. For example, if the financial year end is 31 December 2014, use that date as the 
Start Date for entering the opening trial balance entries, rather than 1 January 2015. 

o If, however, the client is adamant and wishes to convert at some point during the course 
of the financial year, as in the example above, it's a little messy (both for the conversion 
and for the accountant who must collect information from two sources to report the 
financials for that year), but it can be done (see Appendix D: Entering Opening 
Account Balances for entering mid-year financials).  

SHOULD DO: FOR EXISTING COMPANIES 
Record all the transactions up to and including the Start Date in the old system. 

 If possible, perform bank (as well as credit card and loan account) reconciliations for the last 
month up to the Start Date. This will mean that Start Date balances as accurate as possible will 
be entered into QuickBooks, and this will minimise the need to adjust numbers after the 
conversion. 
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SHOULD DO: FOR EXISTING COMPANIES 
Print hard copy reports of balances as of the Start Date.  

 Print out all the reports that you can from the old system as of the Start Date. (Even if they are 
only preliminary reports, print them as you will be able to make changes after the final trial 
balance is produced.) 

o Trial Balance 
o Balance Sheet 
o Accounts Receivable Detail, in the form of a list of open customer invoices and credit 

memos, with the outstanding balance on each. (Nice to Do: If applicable, produce a 
printout of all open estimates provided to customers and unfulfilled incoming sales 
orders.) 

o Accounts Payable Detail, in the form of a list of open supplier bills and credits, with the 
outstanding balance on each. (Nice to Do: If applicable, produce a printout of all 
unfulfilled purchase orders provided to suppliers.)  

o Bank and credit card reconciliation reports for the last month up to and including the Start 
Date. This would include a list of outstanding cheques and deposits (or charges and 
payments) for each account. 

o Stock sub-ledgers (quantities, unit costs and selling prices, and total values). This would 
be an ideal time to conduct a physical stock take. 

o Nice to Do: obtain one or more graphic logos if you want any logos to appear in your 
invoices, credit memos, or other forms. Know where those logos reside on your computer 
or network. 

o Nice to Do: Profit & Loss for the financial year ending in the Start Date. Then you can 
enter a total P&L for the year or 12 P&L’s for each month later on if comparison reporting 
is required. 

o Should Do (for mid-year Start Dates): year-to-date P&L. Nice to Do: year-to-date P&L 
by month if monthly comparatives will be required) 

o Should Do: obtain soft copies (digital listings, usually in spreadsheet format) of the 
various lists in the old system, so that there is a separate row for each name on a list with 
the columns housing the various information fields for each name. There should be a 
separate worksheet for each separate list (suppliers, customers, chart of accounts, 
items).  
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MUST DO: GATHER COMPANY INFORMATION 
Relevant company information is listed below.  

 Must Do: Company Name, Industry (choose “Other/None” if you want to create your own chart of 
accounts rather than have QuickBooks create one for you), and Company Type (sole trader, 
partnership, etc.) 

 Should Do: Address, VAT Registration Number and Business Number 

 Should Do: Payroll Information (if applicable) such as PAYE Reference Number, Contracting-Out 
Number, and the Tax Office Name  

 Must Do: First Month of the Financial Year and the Tax Year 

 Payroll information including receivables by employee if there are outstanding employee 
advances 

 Detailed Loan Information 

 VAT Rates and a copy of the latest VAT Return 

 QuickBooks Usernames and Passwords you wish to establish 

 Nice to Do: Fixed Asset Information 
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MUST DO: CREATE A NEW COMPANY DATA FILE IN QUICKBOOKS  
Use one of the following two methods. 

Use the Express Start 
New users might choose the Express Start option to create a company file from scratch, enabling 
them to start using QuickBooks within three steps.  

1. They would access this abbreviated company setup tool by selecting File > New Company > 
Express Start. While this creates the company file rapidly, this option does leave out 
important information which will eventually have to be filled in by you, the accounting 
professional. One example is that the Express Start method does not allow you to choose that 
you buy, sell, or track stock. Therefore, when the time comes to import items, there is no 
option available to import Inventory items (only Service and Non-Stock items). 
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NOTE: If you select Other/None in the Company Type field, a very short skeleton Chart of 
Accounts will be generated. You may then create other accounts on the Chart of Accounts one at a 
time as you require them. If you wish to import a full Chart of Accounts  previously created or 
used in another software system this can be done later and you will be shown how to do this                                 
is not an option to import accounts on the Chart of Accounts from a spreadsheet (although 
Customers, Suppliers and Items may be imported from a spreadsheet at any time). If you wish to 
import general ledger accounts (rather than enter them manually one by one) later on, you will be 
required to use the techniques to save time described in Appendix G: Advanced Techniques 
to Save Time. 

 



Module 2 Getting Your Client Started: Setting Up and Customising Data Files 

10 
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2. You will now encounter the add your info window. At this point, you may enter more 
information by selecting the area (people with whom you do business, products and services 
you sell, bank accounts) in the window below. However, you are not required to enter any of 
the information via this window. You may select Start Working and then enter the information 
later (either one list name at a time or by importing lists, which will be covered in the next 
step) when it is convenient for you.  
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Use the EasyStep Interview 
QuickBooks also provides a more involved process known as the EasyStep Interview when creating a 
new data file for a company. Although it requires more than three steps, this method does populate 
the QuickBooks data file with more company information that would eventually be required anyway. 

1. Access this interview by selecting File > New Company > Detailed Start. 
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2. This wizard guides a user through a series of choices and options pertinent to establishing a 
company’s financial records in QuickBooks. 

 

The EasyStep Interview is organised into various sections. These sections assist users in: 

 Recording basic information such as company name and address, preferences, and a start date,  

 Selecting the closest Industry type from the drop-down list, this will generate general ledger 
accounts in the Chart of Accounts based on the selection made. If there is no industry listed that 
is close enough to the one required then by selected either General Product based or Genera; 
Service based company a full standard Chart of Accounts will be created and individual accounts 
can be added, deleted or made inactive later on. 

 Confirming the correct legal entity for the business, this will also affect the type of equity accounts 
that are created for example such as partnership accounts and members equity accounts. 

 Setting the first month in the financial year.  QuickBooks will use this information in the calculation 
of profit for each financial period and in any reports where the financial year is chosen to measure 
results. 

 Choosing an Administrators password. This is optional but is recommended where there is more 
than one user as the administrator user has permission levels to add additional users, update 
preferences & grant access to third party applications as well as many other rights. This level of 
access should be protected if possible. 
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  

 

  Defining whether the company is a service-based, product-based business or both. 

 Set-up VAT including entering the registration number & date. QuickBooks supports Standard and 
Flat Rate VAT on both a cash and accrual basis, this can be selected here. 

  
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3. If you choose to leave the EasyStep Interview even after the step in which the company file is 
created, you will be notified that this interview will continue the next time you open this 
company file. 
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4. The next screen capture shows the continuation of the EasyStep Interview after opening the 
company file again. 
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When all the questions in the EasyStep Interview have been answered, you will see a window 
indicating that the interview has been completed. 
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5. You will now encounter the add your info window that appeared much sooner in the Express 
Setup option. At this point, you may enter more information by selecting the area (people with 
whom you do business, products and services you sell, bank accounts) in the window below. 
(Using this EasyStep Interview, which has more steps than the Express Setup, you will have 
the opportunity to specify that stock will be tracked, and therefore you will be able to import 
them.) However, you are not required to enter any of the information via this window. You 
may select Start Working and then enter the information later (either one list name at a time 
or by importing lists, which will be covered in the next step) when it is convenient for you.  
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6. Must Do: Set Company Preferences (see Appendix A) which would determine which 
functions will be available in QuickBooks. It is not necessary that all the company preferences 
(or any of the personal preferences) be set immediately. However, there are some company 
preferences which should be set as soon as possible if they are to be required in the 
company file. Four important preferences which may be of importance to you immediately 
are: Accounting (example: “use account numbers” so that general ledger accounts can be 
referenced by their name or by their number), Items & Stock (example: “stock and purchase 
orders are active” to enable stock tracking), Multiple Currencies and VAT. Without the 
appropriate company preferences chosen, one would be unable to import the right list names 
or information fields on those list names. 

7. Should Do: Import lists that you were unable to import prior to this. If you do have 
worksheets of name lists for Customers, Suppliers, or Items:  

o Select File > Utilities > Import > Excel Files (or select Lists > Add/Edit Multiple List 
Entries) 

o In the Add/Edit Multiple List Entries window, select the list names you wish to import.  
o When importing items that are stock 

 See in the screen capture below that there is an option to import a list of stock 
parts, which is available only if the preference for stock and purchase orders 
are active was selected as indicated in the previous step 

 This feature enables the user to bring in names of items, values, selling prices, 
descriptions, and perhaps most importantly, opening quantities and values. This is 
much easier than entering stock items one by one in the item list.  

 Once a stock item has been created in the item list, however, there is no way to 
import it again with opening quantities (although other parameters such as the 
description and price may be changed upon an import) 

 The only way to enter the opening quantity of a stock or assembly part that is 
already on the item list is to edit each item one by one 

 The importing of a stock or assembly item with a quantity on hand and associated 
value will debit Stock with the value of the new item (the cost multiplied by the 
quantity on hand) and will credit Share Capital 

o See Appendix D: Entering Opening 
Account Balances for more information 
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8. Must Do: Enter opening balances for most accounts.  

o From the trial balance in your old system, enter the opening balance in each of your 
balance sheet accounts (except for Accounts Receivable, Accounts Payable, stock and 
any bank or credit card accounts, which will be discussed separately as they are to be 
treated differently) as of the Start Date 

o You can accomplish this by entering a general journal entry (whereby the "plug" amount 
goes to Share Capital Account to keep opening entries separate from Retained Earnings, 
at least to start) 

o Alternately, you can achieve this by editing each account on the Chart of Accounts and 
entering the opening balance 

 Keep in mind that QuickBooks knows that if an account is a bank, asset, cost of 
goods sold, or expense type of account, a positive number indicates a debit and a 
negative one indicates a credit 

 Conversely, if an account is a liability, credit card, equity, or income type of 
account, a positive number indicates a credit and a negative one indicates a debit 

 In other words, don't jump to the conclusion that a credit balance automatically 
requires a negative number in the opening balance field of an account. It depends 
on the type of account 

o Check the resulting balances of these accounts in QuickBooks against the balances of 
these same accounts in the old accounting system to ensure that the numbers match 
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9. Must Do: Enter the opening balances for Accounts Receivable.  

o From your A/R printout, you now have to enter the amount each customer (and job if you 
are going to track each job or matter of a customer separately) owed to you as of the 
Start Date 

o You could enter the total balance for each name by editing the Customer (or Job) info in 
the customer list, but then you would lose the detail on invoice numbers and dates. You 
would have difficulty showing the customer which invoice(s) they have and have not paid.  

o Instead, if you and the client have the time and the resources, enter an invoice (or credit 
memo) for each outstanding invoice that is owed to you (or credit memo that you have 
issued the customer or outstanding unapplied payment). These invoices should be dated 
and numbered precisely as shown in the printout from your old system.  

o Create a new service item called Opening Balance and link it to the Share Capital 
Account on the chart of accounts. Each invoice does not need the detail of what was sold.  

o Just post the entire outstanding amount of each invoice or credit memo or payment to the 
item called Opening Balance and use a VAT code that results in no tax – usually Outside 
the scope.  If your client works on a Cash Accounting Basis then the invoices and credit 
notes should be entered using the current relevant VAT code inclusive of VAT. This is 
because on a Cash VAT system the VAT only becomes due when the Vat is paid, the 
VAT on these are yet to be declared & will not be included on the last VAT return 
produced. 

o Check that the resulting Accounts Receivable balance in QuickBooks matches the 
Accounts Receivable balance in the old system 

o See Appendix D: Entering Opening 
Account Balances for details 

10. Must Do: Enter the opening balances for Accounts Payable.  

o Similarly, from your A/P printout, enter bills and credits instead of entering just the total 
balance owing to your suppliers (if possible) 

o Leave out memos 
o Number and date them according to the original bills and credits, use the outstanding 

amount of each, and post them to the Share Capital Account 
o Check that the resulting Accounts Payable balance in QuickBooks matches the Accounts 

Payable balance in the old system 
o See Appendix D: Entering Opening 

Account Balances for details 

11. Must Do: Enter opening numbers for stock.  

o If you are tracking stock, go into the items list and enter the stock count of each of your 
items as of the financial year-end date 

o Use this opportunity to enter re-order levels, any costs that you did not include in the 
items import sheet, etc. 

o If you are not tracking stock, then just enter the opening balance of the stock account in 
the same way you did on other balance sheet accounts 

o Check that the resulting Stock Account balance in QuickBooks matches the Stock 
Account balance in the old system 

o See Appendix D: Entering Opening 
Account Balances for details 
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12. Must Do: Enter the opening number and reconciliation status for all bank and credit 
card accounts.  

o Bank and Credit Card accounts must be handled properly for reconciliations to start 
smoothly in QuickBooks 

o For your bank and credit card account(s), enter the balance as per the statement on the 
financial year-end date 

o Then post any individual outstanding cheques, deposits, credit card charges, credits or 
payments as per the bank and credit card reconciliations performed at the financial year-
end 

 Ensure that the cheque number and date are on all cheques (or the date on all 
deposits) 

 Enter the payee on the cheque (or credit card transaction) or leave it blank 
 On deposits, you may keep the Name column blank if you wish 
 Just make sure the face amount of the cheque, deposit or credit card transaction 

is correct 
  If desired, enter a memo of "uncleared transaction from prior year" and post it to 

the Share Capital Account, instead of using the original item(s) or expense 
account(s) from the original transaction 

 Use no VAT code 
 Use the Share Capital Account to post all transactions 
 Check that the resulting bank and credit card balances in QuickBooks match the 

bank and credit card balances in the old system 
 See Appendix D: Entering Opening 

Account Balances for details 

13. Should Do (if using QuickBooks for payroll): Enter payroll information. 

o If you are using a QuickBooks payroll subscription, ensure that all payroll items that are 
going to be required for employee information are set up in QuickBooks 

o Ensure that all employees are entered in the Employee Centre with their 

 Personal information 
 Rate of pay  
 Frequency of pay 
 Tax/NI and sick/holiday information 
 Date hired 
 Payment method 
 Pension Worker Status 

o Include any employees that worked during the tax year, even if they were released by the 
financial year-end date 

o Enter each employee’s tax year-to-date (from April 6) payroll information so that the forms 
P14 and P35 will be correct at the end of this tax year (at April 5 of the next calendar 
year) when submitting the Employer Annual Return as well as the P60 forms that are 
provided to each employee 

 Click on Employees > Payroll Setup > Set Up YTD Amounts and follow the 
steps in order; you will be prompted to enter the tax YTD payroll information for 
each employee 

 Then select Employees > Payroll Taxes and Liabilities > Adjust Payroll 
Liabilities and zero out all the payroll liabilities (for the employer as well as the 
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employee) that show in QuickBooks as a result of these YTD adjustments, as they 
should already have been paid before QuickBooks payroll was in use 

o See Appendix D: Entering Opening 
Account Balances for details 

14. Should Do: Check the QuickBooks Trial Balance.  

o Run and print a trial balance as of the financial year-end in QuickBooks 
o Ensure that it matches the one provided to you at the start 

 The balance in Share Capital Account in QuickBooks should match the balance in 
the Retained Earnings account in the old system 

 If it does not match, find your problem and fix it 
 If it matches, create a general journal entry to put the balance into Retained 

Earnings from Share Capital Account 
 Make Share Capital Account an inactive account on the chart of accounts 
 Let the Trial Balance report refresh itself on the screen and print it out 
 Also print out stock reports and A/R and A/P report as of the financial year-end 

date 
 See Appendix E: Verifying the Company 

File Setup for details 

15. Should Do: Institute a closing date with a password. 

o Secure your Start Date balances by creating a closing date that matches your Start Date 
o Make sure that no live entries for the current financial year are dated on or before that 

Start date 
o See Appendix F: Completing the Setup Process for details 

16. Should Do: Secure Your Data File. 

o Arrange to back up the company data file 
o Also make a copy or backup of the Images directory (which will house any graphics and 

logos that will be included in any customised forms templates below) 

17. Should Do: create users and permissions.  

o Create your company's users, passwords, and levels of access 
o See Appendix B: Setting up Users 

and Permissions for details 

18. Should Do: adjust the figures if necessary.  

o If a final adjusted trial balance is produced down the road by the accountant 

 Make journal entries as of the financial year-end date to adjust your opening trial 
balance in QuickBooks to match with the accountant's numbers 

 Alternately, edit the original preliminary opening entries 
 The Share Capital Account will be adjusted automatically if QuickBooks creates 

any new names with balances, so be on the lookout for editing the general journal 
entry to put that new balance into Retained Earnings. You will need to have the 
closing date password to do this.  

 Re-run the QuickBooks trial balance and other reports, just to make sure that they 
correspond with the final adjusted trial balance 
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19. Nice to Do: Prior Financial Years.  

o If your client wants some information from financial years prior to the conversion date 
entered into QuickBooks 

 Post general journal entries for, say, monthly or yearly summaries 
 You'd need the closing date password to enter them 
 Remember to re-check the opening Retained Earnings balance as of the 

conversion date to make sure that you haven't mucked anything up 

20. Nice to Do: Graphics on Templates.  

o Ensure that you have a digital image of your company's logo (and any other graphics you 
want to incorporate in the QuickBooks forms) on the computer or network 

21. Nice to Do: Forms Templates.  

o Create any templates you might need for invoices, credit memos, statements, packing 
slips and purchase orders, using the image of the logo (and other graphics if necessary) 

o Remember that any forms you create that make use of the logo or any other graphic will 
be automatically copied into a sister folder to your company's data file, located in the 
same main folder, named something like Your company - Images 

o Any time you move the working data file, you must relocate or copy the Images directory 
to the same new place 

22. Should Do: Cover Your Backside.  

o Keep hard copies and soft copies of everything and take them off-site — You never know 
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APPENDIX A: SETTING USER 
AND COMPANY PREFERENCES 

In QuickBooks, Preferences control many of the default settings of the application and, therefore, are 
critical to the accurate and efficient processing of data within the file. Depending on the version and 
edition of QuickBooks being used, up to 22 different categories of Preferences may exist.  

Each of the 22 categories of Preferences may be subdivided into two categories accessed by different 
tabs: My Preferences and Company Preferences. Some preference types have only My 
Preferences, some have only Company Preferences, while most have both. 

My Preferences are customisable by user (the user currently signed into QuickBooks) and are 
generally used to control cosmetic features within the program. For example, a user may choose to 
use the Enter key rather than the Tab key to move from one field to the next within a QuickBooks 
form.  

Company Preferences, on the other hand, affect the way the company file behaves and therefore 
affect all users of a company file. Each company can have a different set of Company Preferences 
(one company’s Company Preferences will have no impact on another QuickBooks company’s 
Company Preferences). An example of a Company Preference would be the interest rate used to 
compute finance charges on past due balances. Only the Administrator of a company file (and, in 
most cases, the External Accountant type of user, who is granted certain administrative rights) may 
modify Company Preferences.  

All Preferences can be accessed by selecting Edit > Preferences from the menu. They are listed in 
alphabetical order. 

ACCOUNTING PREFERENCES 
The Accounting Preferences section contains the most significant Company Preferences. The 
Company Preferences that can be set are listed and explained below. 

 Use account numbers – This activates the account number field in the Chart of Accounts List. 
When activated, transactions may be entered with the account(s) specified by utilising either the 
account number or the account name. 

 Show lowest subaccount only – When using account numbers, checking this box will show only 
the subaccount and not the parent account in transactions involving subaccounts. This option can 
be selected successfully only if all accounts and subaccounts have already been assigned 
account numbers in the Chart of Accounts. 

 Require accounts – Activating Require Accounts requires the offsetting account in a transaction 
to be entered and prevents a transaction from being posted to Uncategorised Income or 
Uncategorised Expense. This preference should always be selected to prevent client errors which 
may be hard to detect, diagnose and correct. 

 Use class tracking – This allows revenues and expenses to be assigned to classes. Classes 
are used to track revenues and expenses by departments, locations, funds, or any other 
meaningful user-defined classification. 

 Prompt to assign classes – This preference causes a message to appear if you try to save a 
transaction which contains an empty class field. 

 Automatically assign general journal entry number – Automatically assigns a number to a 
general journal entry. The number assigned is the number of the previous entry (even an 
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alphanumeric code) plus one. No number is assigned, however, if the number of the previous 
entry is blank. When this preference is off, you need to enter the journal entry number manually. 

 Warn when posting a transaction to Retained Earnings – Displays a warning if you are about 
to post to the Retained Earnings account. In most cases, you should avoid posting directly to this 
account because it is automatically generated by QuickBooks. 

 Warn if transactions are xx day(s) in the past and Warn if transactions are yy day(s) in the 
future – These preferences warn users if transactions are being posted that are significantly in 
the past or in the future. 

 Closing Date and Closing Date Password – Once these preferences are set, QuickBooks 
requires the password to make any changes that would alter balances for the accounting period 
you have closed. This includes editing or deleting transactions entered on or before the closing 
date, and entering new transactions dated on or before the closing date. 
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The Accounting Preferences section has only one option in My Preferences, and it exists only in 
QuickBooks Premier. (There is no such preference available in Pro or SimpleStart.)  

 Autofill memo in general journal entry – Once this is checked, the memo field in the first row a 
general journal entry is automatically copied into the memo field of each subsequent row. 
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BANKING PREFERENCES 
The following Company Preferences can be set for Banking Preferences: 

 Print account names on voucher – This preference sets QuickBooks to print the payee, date, 
and (up to 16 lines) the account name/payroll item/stock item, memo, amount, and total amount 
on the cheque voucher. If this box is unchecked, QuickBooks omits the account name/stock item 
from the voucher.  

 Change non-cleared cheque date when cheque is printed – Activating this preference 
changes the date on the non-cleared (not reconciled) cheque to the date the cheque is actually 
printed instead of the date originally entered on the cheque when it was posted.  

 Start with payee field on cheque – This preference causes the cursor to be positioned so that 
the payee is the first field completed when writing cheques, entering bills, or entering credit card 
charges (instead of the bank, accounts payable, or credit card account). 

 Warn about duplicate cheque numbers – Enabling this setting causes a warning to be 
displayed when using a cheque number that has already been issued. The warning causes 
QuickBooks to take more time to record a cheque. This affects performance significantly if you 
have a large company file.  

 Autofill payee account number in cheque memo – When activated, QuickBooks automatically 
enters the account number on the cheque memo line for each customer, supplier, employee, or 
other name which contains an account number.  

 Select a default account for creating payroll payments – If this Preference is not selected, 
QuickBooks opens the cheque form with the last used bank account; if it is activated, QuickBooks 
defaults to the preferred account when creating a payroll payment. 
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 Select a default account for paying payroll liabilities – If this Preference is not selected, 
QuickBooks opens the cheque form with the last used bank account; if it is activated, QuickBooks 
defaults to the preferred account when creating a cheque for payment of payroll liabilities. 
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Under Banking Preferences, My Preferences allows the individual user to set default accounts when 
writing cheques, paying bills, and making deposits. If a default bank account is not selected, then 
QuickBooks will open the form with the last used bank account.  
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BILLS PREFERENCES 
There are only Company Preferences in this section. The Bills Preferences that can be set are: 

 Bills are due xx days after receipt – Establishes a default due date for accounts payable bills if 
terms or a due date are not entered on the bill. 

 Warn about duplicate bill numbers from the same supplier – Provides a warning message if a 
bill with the same reference number is entered multiple times for the same supplier. 

 Automatically use credits and discounts when paying bills – Causes QuickBooks to apply 
discounts and credits automatically to bills that are being paid. 

 Default Discount Account – If you choose to use discounts automatically in the preference 
above, this option establishes the default discount account and related VAT code to which that 
discounts will be posted. If discounts are not chosen to be used automatically, then this option is 
“greyed out” and unavailable. 
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CALENDAR PREFERENCES 
The Calendar preference contains only My Preferences. The My Preferences that can be set are 
included below.  

The first group of settings is the Calendar Settings, which relate to the calendar itself. 

 Calendar View – This determines whether the user prefers a daily, weekly, or monthly calendar 
view, or if QuickBooks should just recall the last view used 

 Weekly View – This determines how many days in a week you prefer to view the calendar 

o 5 days – to show only Monday to Friday. 
o 7 days – to show the entire week. 
o Variable (5/7 days) – to show 5 days if the Upcoming and Past Due panel which 

appears on the right of the calendar is open, or 7 days if the panel is closed 
(recommended for low screen resolutions) 

 Show – This determines which transactions to display in the calendar. The choices (only one 
choice may be selected) are 

o All transactions 
o To Do 
o Transactions Due 
o Deposit 
o Estimate 
o Invoice 
o Received Payment 
o Sales Order 
o Sales Receipt 
o Bill 
o Cheque 
o Credit Card Credit 
o Purchase Order 
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The second group of settings is the Upcoming and Past Due Settings, which relate to the Upcoming 
and Past Due panel which can be displayed to the right of the calendar. 

 Display – This determines if and how the Upcoming and Past Due panel should be displayed 

o Hide 
o Show 
o Show only if data exists 
o Remember last 

 Upcoming Data – This determines how many days of upcoming data should appear in the panel 
(7, 14, 21, or 31 days) 

 Past Due Data – This determines which past due items should appear in the panel (14, 31, or 60 
days overdue) 
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DESKTOP VIEW PREFERENCES 
The Desktop View tab contains both Company Preferences and My Preferences.  

The Company Preferences in the Desktop View section focus on the features that are shown on the 
Home page, as shown in the following screen capture. 
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The My Preferences that can be set are included below. 

 One Window vs. Multiple Windows – This determines whether information is viewed in a single 
maximised window (default) or whether multiple windows can be open at the same time 

 Desktop – This determines whether any windows open automatically when you start QuickBooks. 
The choices are listed below 

o Save when closing company – When the data file is reopened, the desktop will be just 
as it was when the data file was last closed 

o Save the current desktop – This displays the desktop exactly as it is when the selection 
is made. QuickBooks will rearrange the desktop to the current configuration each time the 
company file is opened 

o Don't save the desktop – This opens QuickBooks to an empty desktop with no windows 
open each time the company file is opened 

o Keep previously saved desktop – This works in conjunction with Save the Current 
Desktop setting to open a pre-configured desktop each time a company file is opened. 
This selection is not available if Save the Current Desktop is not checked. 

 Windows Settings – This allows you to select from among various Windows options for both 
Display and Sounds 

 Company File Colour Scheme – This allows the user to select among 14 pre-configured 
QuickBooks colours which change the colour of the title bar and any open windows  (useful in 
differentiating between companies when more than one company is open in QuickBooks) or 
choose the default colour. 
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FINANCE CHARGE PREFERENCES 
The Finance Charge section contains Company Preferences only. The preferences that can be set 
are included below. 

 Annual interest rate is the interest rate that QuickBooks will use in computing finance charges. 
The rate represents a percentage, so 12.5 equals 12.5% 

 Minimum finance charge is the amount that QuickBooks will charge regardless of the amount 
overdue 

 Grace period is the number of days that must elapse before finance charges will be applied 

 Finance charge account is the name of the account which will be credited with finance charge 
income 

 Assess finance charges on overdue finance charges determines if finance charges will 
compound on other finance charges 

 Calculate finance charges from determines the date on which finance charges accrue if the 
payment is overdue. The choices are listed below. 

o Due date – The finance charges are accrued from the date the invoice is due. An invoice 
that is due in 30 days, but is paid 5 days past due, will be assessed 5 days of interest. 

o Invoice/billed date – The finance charges are accrued from the date of the invoice. An 
invoice that is due in 30 days, but is paid 5 days past due, will be assessed 35 days of 
interest. 

 Mark finance charges “To be printed” determines whether finance charges are automatically 
marked for printing 
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GENERAL PREFERENCES 
The General tab contains both My Preferences and Company Preferences. Company Preferences 
that can be set on the General tab include those listed below. 

 Time format sets the time format for time entries in QuickBooks. The choices include 

o Decimal – All time entries are interpreted as decimal fractions of an hour 
o Minutes – All time entries are interpreted as hours and minutes 

 Always show years as 4 digits enters all year entries as 4 digits. If a valid four-digit year is 
entered, the year is accepted as entered. If a two-digit year is entered, then QuickBooks converts 
entries of 28 to 99 as 1928 to 1999, and entries of 00 to 27 as 2000 to 2027. If the box is not 
checked, then QuickBooks interprets two-digit years using the same sliding date window 
previously identified (while displaying only the last two digits of the year). 

 Never update name information when saving transactions sets QuickBooks to ignore 
changes to named items, such as a customer address, when transactions are saved. Normally, 
QuickBooks will prompt the user to save the change if a change has been made to a field on a 
named item. 

 Save transactions before printing is a security feature that records a transaction that has not 
yet been saved if it is being printed, e-mailed, or saved as a PDF 
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MY PREFERENCES 
The My Preferences that can be set include the following items. 

 Pressing Enter moves between fields changes the default key to move between fields from Tab 
to Enter  

 Automatically open drop-down lists when typing causes drop-down lists to automatically 
appear whenever typing occurs in a field where a drop-down list is available 

 Beep when recording a transaction provides audible feedback when a transaction is recorded 

 Automatically place decimal point automatically places a decimal point between the second 
and third digits of any amount that is entered in QuickBooks. QuickBooks is thus behaving like an 
adding machine when monetary amounts are entered. 

 Warn when editing a transaction warns a user when a change is made to a transaction, but the 
transaction is not recorded before leaving the form. If the box is not checked, then QuickBooks 
allows a user to leave a transaction without warning. The transaction is automatically recorded if 
the transaction is not linked to other transactions. If there are links, then QuickBooks prompts the 
user to record the transaction. 

 Bring back all one-time messages returns all system information messages that are displayed 
once 

 Turn off pop-up messages for products and services suppresses pop-up messages related to 
additional products and services offered by Intuit 

 Show ToolTips for clipped text displays tips when text is clipped because a field is too small on 
a form or text will not fit on a report or graph 

 Warn when deleting a transaction or unused list item warns a user when a transaction or 
unused item is deleted. If the box is not checked, then QuickBooks allows the deletion without 
warning. 

 Keep QuickBooks running for quick startups keeps a portion of the QuickBooks program 
running as a process in Windows even when you exit QuickBooks. This enables QuickBooks to 
open quickly but it does use computer resources to accomplish this. 

 Automatically remember account or transaction information allows users to specify whether 
future transactions are based on prior transactions and whether supplier transactions are pre-
filled with accounts used in prior entries. The options for this are below. 
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 Automatically recall last transaction for this name sets up QuickBooks to remember 
the previous transaction for a person. When you enter a new transaction, QuickBooks 
automatically fills out the form with information you entered in the last transaction of that 
type for that person. For example, when you enter a supplier's name on a bill and press 
Tab, QuickBooks fills in the bill just like the most recent one you entered for that supplier. 

 Prefill accounts for supplier based on past entries sets up QuickBooks to pre-fill the 
account for a supplier transaction based on previous transactions for that supplier. 
QuickBooks remembers all your recent transactions for a supplier, not just the most 
recent one. If you consistently use the same account for a supplier, QuickBooks will 
automatically pre-fill that information any time you select the supplier in a bill or credit 
card transaction. Note: This preference only recalls accounts used for a supplier on 
supplier specific transactions such as entering a bill or paying a bill. QuickBooks will not 
recall accounts used with a supplier on other transactions such as cheques. 

 Default Date to Use for New Transactions allows the user to specify whether the default date 
should be either the current system date (the date that Windows recognises as the current date, 
i.e. “today”) or the date of the last transaction entered. 

 Keep custom item information when changing item in transactions changes the way 
QuickBooks handles a customised item description in transactions if the item is changed after a 
customised description has been entered 

 

INTEGRATED APPLICATIONS PREFERENCES 
Integrated applications are programs that are written to work with QuickBooks and generally provide 
additional functionality for specific needs or tasks. These applications can often both read from and 
write to the QuickBooks database file. For security purposes, Intuit has provided this preferences 
screen so that the QuickBooks administrator can control which applications have these rights. This 
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prevents unauthorised individuals from making changes to the QuickBooks database or from even 
accessing confidential data to which they should not have access. 

The specific Company Preferences available in this section are listed below. 

 Don’t allow any applications to access this company file – This option is turned off by default 
and should be turned on if no third party applications need to access the QuickBooks database 

 Notify the user before running any application whose certificate has expired – If a third 
party application has an expired certificate, activating this Preference will cause a notification to 
appear, warning of a potential security breach 
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ITEMS & STOCK PREFERENCES  
There are only Company Preferences in this section, and they are comprised of those listed below. 

 Stock and purchase orders are active provides access to the stock features of QuickBooks, 
including the ability to create stock part items, create purchase orders, and create stock-related 
reports 

 Warn about duplicate purchase order numbers causes QuickBooks to provide a warning if the 
same purchase order number is used on multiple occasions 

 When calculating Quantity Available for my stock deduct: determines whether QuickBooks 
deducts quantities reserved for Pending Builds and/or Sales Orders when calculating the 
quantities of stock available 

 Warn if not enough stock to sell warns a user when an attempt is made to sell more of a stock 
item than is in stock (calculated either by what is on hand or by what is available) 

 Unit of Measure enables QuickBooks’ unit of measure conversion features 
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JOBS AND ESTIMATES PREFERENCES 
Only Company Preferences exist for Jobs and Estimates, and they are comprised of those listed 
below. 

 Job status descriptions – Descriptions for pending, awarded, in progress, closed, and jobs not 
awarded can be modified 

 Do you create estimates? – This sets up QuickBooks to use estimates 

 Warn about duplicate estimate numbers – QuickBooks will warn users when an estimate with 
the same number as a previous estimate is recorded. This will affect performance, especially for 
large company files. 

 Close estimates after converting to invoice – This marks the estimate as closed once it has 
been invoiced. 

 Do you do progress invoicing? – This sets up QuickBooks to do Progress Invoicing 

 Don’t print items that have zero amount – This prevents items with zero amounts from printing 
on Progress Invoices 
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MULTIPLE CURRENCIES PREFERENCES 
This section contains only Company Preferences.  

 Track multiple currencies in this company file? This determines whether or not you wish this 
company file to track more than one currency. This option, once enabled, cannot be turned off. 
It is strongly recommended that prior to enabling multiple currencies you back up the company 
data. 

 Select the home currency you use in transactions allows you to determine the currency for 
reporting financials, payroll and filing VAT. When using multiple currencies, the home currency is 
used in calculations for nearly all amounts stored in a transaction. This means you cannot change 
the home currency once it is selected. Certain features and services — such as QuickBooks 
Payroll — require that the home currency be set to the Great British pound (GBP). Also, you can 
download updated exchange rates only if the home currency is the Great British pound (GBP, 
also known as the Pound Sterling), Euro (EUR), Canadian dollar (CAD), South African rand 
(ZAR), US dollar (USD), New Zealand dollar (NZD), or Australian dollar (AUD). If the home 
currency is not one of these currencies, you must manually update the exchange rate before 
entering transactions that use different currencies. 

 Once you have turned on Multicurrency you can no longer use the following features - 
Insights, Income Tracker, Bill Tracker, Batch Invoicing, Batch Delete/Void Transactions, or 
choose multiple customers in the Invoices for Time and Expenses window.  In addition you cannot 
convert a file with Multicurrency to QuickBooks online using the Export Company File to 
QuickBooks Online tool.  Conversion will need to be done by using one Intuit’s conversion 
partners. Check the Intuit website for current details.  
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PAYMENTS PREFERENCES 
This section contains only Company Preferences. The only preference in this section is: 

 Receive Payments – These checkboxes allow you to customise how the Receive Payments 
function works in QuickBooks 

o Automatically apply payments – This preference causes QuickBooks to apply a 
customer's payment automatically to the outstanding invoices for that customer. If the 
amount received is less than the customer's outstanding balance, QuickBooks applies the 
payment to the oldest invoices first. When this preference is off, QuickBooks does not 
automatically apply customer payments. You must specify how to apply each payment 
when you are in the Receive Payments window. 

o Automatically calculate payments – When this preference is on, you can select an 
invoice in the table of the Receive Payments form before entering an Amount Received, 
and QuickBooks prefills the amount of that selected invoice into the Amount Received 
field. QuickBooks continues to automatically calculate the Amount Received based on the 
invoices you select or deselect for that payment. When this preference is off, QuickBooks 
does not automatically calculate payments. You need to click Auto Apply to see the 
results of your payment on the amounts for selected invoices. 

o Use Undeposited Funds as a default deposit to account – This preference causes 
QuickBooks to set Undeposited Funds as the default account for depositing payments. 
When this preference is off, QuickBooks displays the Deposit To field on the Receive 
Payments and Enter Sales Receipt windows. You must click a destination account from 
the drop-down list. 
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PAYROLL AND EMPLOYEES PREFERENCES 
There are only Company Preferences on the Payroll & Employees tab. The Company Preferences 
that can be set are detailed in the following list. 

 QuickBooks Payroll Features – “Full payroll features” enables QuickBooks payroll functionality 
(if payroll has been enabled by subscription). “No payroll” disables payroll features. 

 Recall quantity field on payroll payments – This determines whether QuickBooks automatically 
carries forward quantities from the last payroll payment 

 Recall hour field on payroll payments – This determines whether QuickBooks automatically 
carries forward hours from the last payroll payment 

 Job Costing, Class & Item tracking for payroll payment expenses – Select this option if you 
want QuickBooks to itemise company-paid payroll expenses by job, item, or class. The expenses 
are proated in the same proportion as an employee's prorated earnings. Additions, commissions, 
and company-paid distributions are also tracked if you select "Track Expenses by Job" in the 
setup of the individual payroll items.  

 Assign one class per job Entire Payroll Payment or per Earnings item 

o Entire payroll payment – Click this option to have QuickBooks assign a class you 
specify to all payroll expenses, including employer-paid taxes, on the payroll payment. 

o Earnings item – Click this option to have QuickBooks add a Class column to the 
Earnings section of the Review Or Change Payroll Payment window, which gives you the 
ability to assign a separate class to each payroll item listed in the Earnings section. If you 
select this option, QuickBooks also assigns classes to any additions or employer 
contributions on employee payroll payments, based on the classes assigned to earnings 
items. If the earnings items are assigned to more than one class, QuickBooks prorates 
the class assignments of the additions and employer contributions based on the 
prorations of the earnings items. 

 Pay Slip and Voucher Printing (Printing Preferences) – This controls which fields appear on 
pay slips and payroll payment voucher sections 

 Display employee list by – This displays employee item list in first name or last name order 

 Mark new employees as sales reps – This allows employees to be marked as sales 
representatives for individual customers or suppliers 

 Employee Defaults – Enter the payroll information that most employees have in common, such 
as deductions for pensions, health insurance, or union dues. The default setup saves you time, 
because you enter this information only once. When you are setting up the payroll record for a 
new employee, QuickBooks automatically fills in the information you entered into the default 
setup. If you need to, you can customise any of the prefilled information for each employee. 
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REMINDER PREFERENCES 
All of the Company Preferences relate to whether identified events appear in the Reminders list. (The 
only My Preference that can be set on the Reminders tab is whether QuickBooks is to show the 
Reminders list each time the company file is opened.) The events include cheques to print, payroll 
payments to print, invoices/credit memos to print, overdue invoices, sales receipts to print, sales 
orders to print, stock to reorder, assembly items to build, bills to pay, memorised transactions due, 
money to deposit, purchase orders to print, and To Do Notes. For each item, select one of the 
following. 

 Show summary shows a summary total of the items or amounts referenced by that event 

 Show list shows a summary total and then a detail line for each item included in the summary 
referenced by that event 

 Don't remind me prevents a reminder for that event list. 

Some of the listed events allow a stipulation of the number of days before the due date that the 
reminder will appear in the Reminders list. 
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REPORTS AND GRAPHS PREFERENCES 
The Reports and Graphs tab contains both My Preferences and Company Preferences.  

The Company Preferences that can be set are given below. 

 Summary reports basis sets the default method of calculating and presenting summary reports 
to cash basis or accrual basis 

 Ageing reports sets the ageing reports for outstanding invoices and bills to be calculated based 
on either Age from the due date or Age from transaction date 

 Format allows the setting of report defaults, such as title, header, footer, font, how to format 
amounts, and whether zero amounts are printed, etc.  

 Balance Sheet Format specifies the format for balance sheet reports. Balance sheets are 
available from the Reports menu under Company & Financial. The names of balance sheet menu 
options change depending on your selection 

o UK Standard Balance Sheet – Financial data is organised to meet the legal criteria 
required by UK accountants and government agencies 

o QB Standard Balance Sheet – Financial data is organised based on other international 
versions of QuickBooks. These formats meet North American accounting principles and 
criteria. 

 Reports – Show Items by : sets whether Items names, item descriptions, or both are included in 
reports 

 Reports - Show Accounts by: sets whether account names, account descriptions, or both are 
included in reports 

 Classify Cash… allows the modification of the statement of cash flows as required 



Module 2 Getting Your Client Started: Setting Up and Customising Data Files 

52 

 

 

 

 

 

 

 

 

The My Preferences that can be set are listed below. 

 Prompt me to modify report options before opening a report – When selected, the Modify 
Report window opens automatically when a report is created. This can save time, particularly on 
reports that take a long time to produce but generally have to be modified anyway. 

 Reports and Graphs – This determines how reports or graphs which are already displayed are 
updated to reflect new information. (Some reports and graphs should be recomputed from 
scratch. Automatic refreshes of those types of reports and graphs would affect performance, so 
QuickBooks gives users the following options of how to handle their updates.)  

o Prompt me to refresh – When a report or graph needs to be refreshed, QuickBooks will 
prompt the user to choose whether it should be refreshed or not 

o Refresh automatically – Reports are automatically refreshed. In a multi-user system, 
this may cause reports to be refreshed over and over as others enter new data, having a 
negative impact on system performance 

o Don't refresh – QuickBooks does not update the report or graph, nor does it prompt that 
the report or graph needs to be updated 
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 Graphs only – This determines whether two-dimensional graphs are created instead of the 
default three-dimensional graphs. Selecting two-dimensional graphs can improve performance. 
Additionally, users are prompted to select Use patterns instead of colours for graphs, which is 
useful in printing complex graphs in black and white.  

 

SALES AND CUSTOMERS PREFERENCES 
The Company Preferences that can be set in the area of Sales and Customers are numerous. 

 Usual Shipping Method sets the default shipping method on sales forms, although this can be 
over-ridden on the individual form 

 Usual FOB sets the usual FOB on sales forms. This, too, can be over-ridden on the individual 
sales form 

 Warn about duplicate invoice numbers displays a warning message when an invoice number 
is used on multiple occasions. Enabling this option can negatively impact performance, especially 
with a large company file 

 Choose template for invoice delivery note allows a default template to be specified for invoice 
delivery notes 

 Use price levels determines whether Price Levels can be utilised for the company 

 Enable Sales Orders determines whether Sales Orders are enabled. (Sales orders are available 
only in QuickBooks Premier.) When this Preference is enabled, users can also specify whether a 
warning should be displayed in the event a Sales Order Number is used on more than one 
occasion, and whether items with zero amounts should be printed on the Sales Order. 

 Choose template for delivery note allows a default template to be specified for sales order 
delivery notes 
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 Choose template for pick list allows a default template to be specified for sales order pick lists 

 Enable Collections Centre enables this credit control centre where clients can send, monitor 
and record correspondence with customers with outstanding balances. 

 Custom Pricing enables the Price Levels Price which lets you set custom pricing for different 
customers or jobs. Per item price levels is only available in QuickBooks Premier. 

  

The Sales & Customers tab includes only one My Preference. 

 Add Available Time/Costs to Invoices for the Selected Job – this Preference controls what 
happens when you create an invoice or sales receipt for a customer or job with outstanding 
billable time, expenses, mileage, or other items 
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SEARCH PREFERENCES 
The Search tab includes only Company Preferences. There are really only two preferences, which are 
to update the search information automatically (so that changes in the company file can appear in 
search results), and how often (intervals range from every five minutes to every 60 minutes). There is 
also the option to choose Update Now. 

 

SEND FORMS PREFERENCES 
The Send Forms tab includes Company Preferences and My Preferences. The Company Preferences 
that can be set are listed below. 

 Change default for allows specification of different text to appear for different types of forms to 
be sent (such as invoices, estimates, statements and so on) 

 Salutation lets the default salutation be Dear or To 

 Customer contact name allows the default address name to be First name, Last name, or 
Mr/Ms/Mrs Last name 

 BCC lets you specify a default e-mail address to which all the forms of the same type are blind 
copied 

 Subject controls what appears in the subject line of the message 

 Cover note body is the default text that accompanies the sent forms but it can be modified as 
required 
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The My Preference that can be established is Auto-check the “To be emailed” checkbox if 
customer’s Preferred Send Method is E-mail. This determines whether customer forms are 
automatically enabled for email. 

There is also a radio button which, if clicked, can enable sending forms from QuickBooks via web-
based e-mail such as Hotmail, Gmail and Yahoo, rather than by using an e-mail client. 
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SERVICE CONNECTION PREFERENCES 
The Service Connection Preferences include both Company Preferences and My Preferences. These 
Preferences relate to settings for connections to outside services that interface directly with 
QuickBooks. The Company Preferences that can be set include the following. 

 Automatically connect without asking for a password – All users of the same company file 
will automatically be logged in to the outside service without having to provide a Login name or 
password 

 Always ask for a password before connecting – Users of the same company file will be 
required to provide a Login name and password each time they access the outside service 

 Allow background downloading of service messages – When selected, Service updates are 
automatically downloaded from the Intuit server 

 

  



Module 2 Getting Your Client Started: Setting Up and Customising Data Files 

58 

Available My Preferences include the following. 

 Give me the option of saving a file whenever I download Web Connect data – Whenever 
Web Connect data is downloaded from a Financial Institution or a file containing previously 
downloaded Web Connect data is opened, the prompt asks users if they want to process the 
transactions immediately or to save them to a file for later processing 

 If QuickBooks is run by my browser, don't close it after Web Connect is done – If 
QuickBooks is launched by downloading Web Connect data from a financial institution or by 
double-clicking on a file containing previously downloaded Web Connect data, then it will remain 
open after the downloaded transactions are processed 
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SPELLING PREFERENCES 
The Spelling Preferences tab includes only My Preferences that can be set; these include those listed 
below. 

 Always check spelling before printing, saving, or sending supported forms will run the spell 
checker automatically when Save and Close or Save and New is chosen in the document creation 
window 

 Ignore words with allows the configuration of spell check to ignore certain words and phrases, 
including: Internet addresses; numbers; capitalised first letters, such as in proper names; all 
uppercase letters, such as acronyms or abbreviations; and mixed case words, such as 
ProAdvisor. You can add your own custom words that you do not wish to be spell checked (or 
remove custom words from the list of exempt words). 
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TIME & EXPENSES PREFERENCES   
The Time & Expenses tab includes only Company Preferences: 

 Do you track time? determines if Time Tracking is activated for the QuickBooks company 

 First day of the work week allows users to define work weeks. Weekly timesheets will reflect the 
first day of the work week, as specified in this Preference. 

 Invoicing options allow you to invoice customers and jobs quickly and efficiently 

o Create invoices from a list of time and expenses 
o Track reimbursed expenses as income 

 Default markup percentage 
 Default markup account 
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VAT PREFERENCES 
The VAT tab includes only Company Preferences. 

 Do You Charge VAT? – When activated, this sets up QuickBooks to use VAT in invoices, credit 
memos and sales receipts 

 VAT Scheme – The Schemes available are Standard or Flat Rate 

 VAT Registration Date – Enter the date of registration. This is useful if the Flat Rate Scheme is 
being used and the 1st year discount is being claimed. It is important to note that QuickBooks will 
not automatically update the rate after the first year anniversary however it is a good idea to set a 
reminder within QuickBooks to remind you of the anniversary change. 

 VAT % - This box is only visible if Flat Rate Scheme is selected. Enter the Flat Rate percentage 
that is relevant for the industry type. 

 Customer and Supplier codes – These options allows you to choose to set VAT codes for 
customers, suppliers, or both 

 Display VAT – Checking this box allows for VAT inclusive prices and costs to be entered 

 Assign VAT Codes – This allows for specification of default VAT code on taxable items as well 
as the default code on tax-exempt items 

 VAT Rounding Adjustments – This option allows you to determine how QuickBooks should 
behave regarding net amounts and gross amounts when a rounding due to VAT must be done 
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APPENDIX B: SETTING UP USERS 
AND PERMISSIONS 

Security and control have always been basic functions of almost every accounting information system. 
For this reason, using QuickBooks Pro and QuickBooks Premier are preferable to using QuickBooks 
SimpleStart because these two applications provide additional levels of security not found in 
QuickBooks SimpleStart. 

Access to QuickBooks can be limited to authorised users. Each user should have a unique username 
and password. Users may be limited to specific areas of QuickBooks, and certain functionality may be 
limited or prohibited on a user-by-user basis. Until users are set up in QuickBooks, any person who 
accesses the company data file will have full Admin (see next paragraph) user access to all data, 
transactions, and reports. Also, only one person can access the company file at a time until other 
users have been set up. To provide for concurrent usage of the same company file by multiple users 
or to restrict access, users must be established. 

The default user is Admin, the Administrator. Administrators have super-user, wizard-like rights and 
permissions. In other words, Administrators have full access to the system. They have unlimited 
access to all of the data in a company file, and only the Administrator can add, change, or delete 
users, or change Company Preferences. There can only be one Admin user. Although all other users 
are created by the Admin user (and he or she may create an External Accountant type of user who 
does have some Admin powers), another Admin user cannot be created. 

It is vital that you set up a separate user ID and password for each user who will be accessing 
QuickBooks. If you do not, the audit trail will show what was done and when it was done, but 
 not who did it. 
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SETTING UP USERS 
The Admin user will want to establish his or her password. From the menu, choose Company > Set 
Up Users and Passwords > Change Your Password… (or Company > Set Up Users and 
Passwords > Set Up Users and then with Admin user highlighted in the User List, select Edit User…. 
The default user name for the first account is Admin, the administrator for the company file. Enter a 
password for Admin and confirm the password, as shown in the screen capture below. 

 

NOTE: Although you may change the name of the administrator, we recommend the use of Admin 
as the name for the administrator account. While this Admin name can be changed, for example to 
John, the Admin user may sign in using either the name Admin or the new name. 

The administrative password should not be known by other users. Should it become compromised, it 
should be changed immediately. Even if the administrator is the primary user, that person should 
generally have another user account in QuickBooks that can be used on a daily basis when posting 
transactions and running reports. The administrator username and password should only be used 
when performing tasks requiring exclusive Administrator rights. 
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Once the Admin password has been set, create other users. Select Company > Set Up Users and 
Passwords > Set Up Users the User List dialogue box will appear, as shown below. Note that new 
users can be created, and the user names and profiles of existent users can be edited or deleted from 
this dialogue box. 

  

To create additional users, choose Add User. The Add User Wizard begins the process of setting up 
a new user and granting the user rights and permissions. 

 

For each user, access can be granted or restricted to specific functional areas of QuickBooks. Each 
user can have No Access, Full Access, or Selective Access to the area or feature. If the user is 
granted selective access to an area, the access can be limited to:  
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 Create transactions,  

  Create and print transactions, or  

 Create transactions and create reports.  

The functional areas where access can be controlled are: 

 Sales and Accounts Receivable 

 Purchases and Accounts Payable 

 Banking and Credit Cards 

 Stock 

 Time Tracking 

 Payroll and Employees 

 VAT 

 Sensitive Accounting Activities 

 Sensitive Financial Reports 

 Changing or Deleting Transactions 

 Changing Closed Transactions 

At the end of the user creation process, the wizard displays a summary of the access rights for the 
newly created user, as shown below. 

  

Create each user, in turn, and assign appropriate rights and permissions. Make sure to limit the ability 
of every user to change closed transactions. Then, only the administrator will be able to change 
closed transactions. 

NOTE: Setting up a user account for each user enhances internal control. Firstly, users will be 
limited in their use of the company file to just those tasks which they have authority to perform. 
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Second, the Audit Trail will identify each transaction as to date, time, and user who entered, 
deleted, or modified the transaction. 

Giving the Accountant Full Access 
Whether or not the external accountant has full access to the client’s accounting records is something 
that needs to be agreed between the accountant and the client. However, in most situations, it is an 
absolute requirement that the outside accountant or QuickBooks consultant have complete and full 
access to the accounting systems for small businesses.  

Under these circumstances, the outside accountant/consultant should always have a unique 
username for the client’s company file. This not only provides an audit trail of the changes made by 
the accountant, but also provides the opportunity to create a report of all the transactions, corrections, 
and changes made. This is particularly useful if the accountant has made several corrections that 
significantly reduce cash or some other account balance.  
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APPENDIX C: IMPORT LIST NAMES FROM OTHER 
SOURCES TO EXPEDITE SETUP 

If, after creating the company data file by using either Express Start or the EasyStep Interview, you 
have lists of names (items, suppliers or customers/jobs) which you would like to import into 
QuickBooks, there is an elegant method of achieving that end. 

NOTE: If there are other list names such as accounts on the Chart of Accounts or Payment Terms 
that must be added to the QuickBooks company file, these names may be entered one at a time in 
QuickBooks, or they may be imported using IIF files. (See Appendix G: Advanced Techniques 
to Save Time.) 

PRECAUTIONS: After you create the QuickBooks data file, there will hopefully be some name lists 
to import, so that you do not have to enter list names (such as items, accounts, customers) 
manually one at a time. It is prudent to perform a distinctly-named backup before you do any new 
importing or entering of balances into your new data file so that you can restore from the backup 
in case you make a mistake. Best practice is to keep an historical trail of backups (i.e. 
"generations" of backups) so that you can go back to almost any version of the data file you are 
building. For example, a backup prior to importing items and quantities on hand might be named 
“CompanyFilePriorToItemAndQOHImport.QBB.” 

1. For each list, start with that particular list in QuickBooks. For example, for suppliers, select 
Suppliers > Supplier Centre or choose the Suppliers icon. Select New Supplier and then 
choose Add Multiple Suppliers. 
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2. The Add/Edit Multiple List Entries window appears (with Suppliers already selected in the List 
drop-down box), at which point you may copy and paste columns from your source data into 
the appropriate columns of this window. In fact, you may select Customise Columns to add, 
remove or reposition the columns you want to use.  

A time saving tip regarding such activities as clearing columns, duplicating rows and copying 
down might appear. If it does, select OK. 

 

3. Select Customise Columns if there are any columns that should be added or taken away 
from this spreadsheet view. Copy and paste the information fields from the appropriate 
columns of your source file into the correct columns of the Add/Edit Multiple Entries List 
and make any changes necessary by direct editing or by inserting a line, deleting a line, 
copying down, duplicating a row, or clearing a column. 

4. Select Save Changes and Close. 
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1. To access Add/Edit Multiple List Entries window from the Customer Centre, select 
Customers > Customer Centre or choose the Customers icon. Select New Customer & 
Job and then choose Add Multiple Customer:Jobs. 
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2. The Add/Edit Multiple List Entries window appears with Customers already selected in the List 
drop-down box. 

 

1. To access Add/Edit Multiple List Entries window from the Item List, select Lists > Item List or 
select Suppliers > Item List. Select Item and then choose Add/Edit Multiple Items. 
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2. The Add/Edit Multiple List Entries window appears with Service Items already selected in the 
List drop-down box (and Stock Parts and Non-Stock Parts can be chosen as well from the 
same drop-down list). 

 

3. Once the Add/Edit Multiple List Entries window is open, regardless of how it was accessed, 
you may select a different list for importing names. Only one type of list may have names 
imported from this list at a time (for instance, only Stock Items or only Suppliers). 



Module 2 Getting Your Client Started: Setting Up and Customising Data Files 

72 

APPENDIX D: ENTERING OPENING 
ACCOUNT BALANCES 

Regardless of the method chosen to create the new data file, the following procedures should be 
utilised for entering opening balances. By following these procedures, users can be assured that they 
will have entered all of the necessary details to reconcile the chequing account and to manage 
Accounts Receivable and Accounts Payable. 

ENTER BALANCES OTHER THAN BANK AND CREDIT CARD ACCOUNTS, 
A/R, A/P, STOCK, AND VAT PAYABLE 
Create a general journal entry for the opening balances of all accounts except your Bank Accounts, 
Credit Card Accounts, Accounts Receivable, Accounts Payable, Stock, and VAT Payable. Post the 
difference in debits and credits to the Share Capital Account, the QuickBooks clearing account which 
is used for offsetting setup entries. To create the general journal entry, select Company > Make 
General Journal Entries… from the menu. Enter a journal entry similar to the one shown below, but 
using the balances from your client’s trial balance.  
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ENTER BANK AND CREDIT CARD ACCOUNT BALANCES 
Enter the opening balance (per the statement for each of these accounts as of the start date) of each 
bank and/or credit card account directly into the account, as shown in the screen capture below (a 
bank account is being used for this example, although a similar method would be used for a credit 
card account). This method posts the offsetting balance to Share Capital Account and insures that the 
amount entered appears as the Beginning Balance in the first bank and/or credit card reconciliation. 
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ENTER OUTSTANDING BANK CHEQUES, SERVICE CHARGES 
AND DEPOSITS 
All outstanding bank transactions – cheques and deposits – that occurred on or before the Start Date 
should be entered directly into the account register for the appropriate bank account. This will insure 
that the transactions will appear in the first bank reconciliation. From the menu, select Lists > Chart of 
Accounts. Double click on the bank account to open the register. Enter each outstanding transaction, 
dated at the transaction date, and post the offset to the Share Capital Account, as shown below. 

An alternative to entering these outstanding transactions directly into the register is to enter individual 
cheques, charges, or withdrawals with the correct cheque number, service charge code or withdrawal 
number, date (and payee, if desired), as well as amount, all posted to the Share Capital Account. 
Similarly, any outstanding deposits would be entered as deposits to the account with the correct date, 
amount, and posted to the Share Capital Account. 

NOTE: The Ending Balance, after entering all outstanding cheques and deposits, should equal the 
account balance for the account in the Trial Balance as of the Start Date. 

 

Entering the outstanding credit card account transactions would be done in a fashion similar to 
entering the outstanding bank account transactions shown above. 

  



Module 2 Getting Your Client Started: Setting Up and Customising Data Files 

75 

ENTER OUTSTANDING ACCOUNTS RECEIVABLE AND 
ACCOUNTS PAYABLE TRANSACTIONS 

Account Receivable 
Create an Invoice for each open invoice in Accounts Receivable (corresponding to positive accounts 
receivable amounts, or a debit amounts in accounts receivable) as of the Start Date. Date each 
invoice as of the transaction date and include all details — customer, terms, etc. — in the invoice. For 
the amount, use the outstanding gross invoice amount (which may differ from the original amount of 
an invoice if a partial payment had been received) including VAT (although do not split out any VAT). 
Be sure to use a Service Item (named something like Opening Balance) that is linked to the Share 
Capital Account. Create a Credit Memo for each open credit memo or unapplied payment (which 
corresponds to negative accounts receivable amounts, or credit amounts in accounts receivable).  

A customer invoice is shown in the screen capture below. 
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Accounts Payable 
Create a Bill for each unpaid bill in Accounts Payable (corresponding to positive accounts payable 
amounts, or credit amounts in accounts payable) as of the Start Date. Create a Bill Credit for each 
open bill credit or unapplied supplier bill payment as of the Start date as well (corresponding to 
negative accounts payable amounts, or debit amounts in accounts payable). Again, date the bills and 
bill credits as of their transaction dates and include all details such as the bill number, but be sure to 
post these bills and bill credits to the Share Capital Account or use a Service Item linked to the Share 
Capital Account . Again, use the gross amount outstanding of each transaction and do not split out 
the VAT amount. 

Entering each open Accounts Receivable Invoice and Accounts Payable Bill (rather than entering a 
total Current Balance as of the Start Date for each Customer and Supplier) insures that the ageing of 
accounts is accurate. Furthermore, payments by customers or to suppliers can be matched to a 
specific Invoice or Bill, and detailed job costing and class tracking information is preserved. 

ALTERNATE SETUP OF ACCOUNTS RECEIVABLE AND ACCOUNTS 
PAYABLE 
Here is another elegant option for setting up detailed open Accounts Receivable and Accounts 
Payable transactions as of the Start Date. Create a new account on the Chart of Accounts called 
Receivables old system and make it an Other Current Asset account. Then create a new account on 
the Chart of Accounts called “Payables old system” and make it an Other Current Liability account. 

When setting up the general journal entry for the Start Date opening balances for all accounts other 
than banks, credit cards and stock, enter the total balance for receivables and payables by including 
these two new accounts in that entry. However, instead of posting total receivables to Accounts 
Receivable, post it to Receivables, Old System. And instead of posting total payables to Accounts 
Payable, post it to Payables, Old System. 

Then create a new service item called Opening Receivables and link it to the Receivables, Old 
System account. Similarly, create a new service item called Opening Payables and link it to the 
Payables, Old System account. 

Accounts Receivable 
Enter the outstanding balance of each invoice, unapplied payment and credit memo as described in 
the previous Accounts Receivable section, and use the item Opening Receivables in each entry. 
This will increase Accounts Receivable and gradually diminish the balance in the Receivables, Old 
System account. You will know that you have entered all the receivables that were outstanding as of 
the Start Date when the balance in the Receivables, Old System account is zero while the balance in 
the true Accounts Receivable account is the desired amount from the trial balance. 

Accounts Payable 
Enter the outstanding balance of each bill, unapplied payment and bill credit as described in the 
previous Accounts Payable section, and use the item Opening Payables in each entry (or use the 
actual account Payables, Old System on the chart of accounts if you prefer not to use items). This 
will increase Accounts Payable and gradually diminish the balance in the Payables, Old System 
account. You will know that you have entered all the payables that were outstanding as of the Start 
Date when the balance in the Payables, Old System account is zero while the balance in the true 
Accounts Payable account is the desired amount from the trial balance. 
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ENTER DETAILS FOR NON-POSTING ITEMS 
In a fashion similar to entering all open customer invoices and supplier bills, record all open Purchase 
Orders, Estimates, and Sales Order. Date each transaction as of the transaction date and make sure 
to enter all necessary details. 

NOTE: If you have partially received items on an open Purchase Order, enter the detail only for 
those items that have not been received. Likewise, if you have progress billed a customer for a 
part of an Estimate or shipped and delivered part of a Sales Order, enter only the remaining 
amounts to be invoiced.  

ENTER MID-YEAR INCOME AND EXPENSES 
Although the optimal point at which to create a Start Date is at a financial year-end, a company file 
may be set up mid-year. If the company file is being set up at some point during a company’s financial 
year, enter a journal entry that summarises the financial year-to-date balances in all income and 
expense accounts as of the Start Date. Post the difference in debits and credits to the Share Capital 
Account. If at all possible, for ease of use, create the Start Date at the end of a month. 

ADJUSTING VAT PAYABLE 
The opening balance for VAT Payable must be adjusted to the amount indicated in the Trial Balance 
as of the Start Date. This adjustment should be made after all open invoices are entered because 
recording open Invoices will affect the balance in VAT Payable. The amount of the adjustment will be 
the amount on the Trial Balance less any amounts recorded in VAT Payable as a result of recording 
open Invoices. For example, if the Trial Balance indicated that the balance of VAT Payable was 
£1,500.50, the amount of the adjustment to be entered would be £1,500.50. To enter the adjustment, 
select VAT > Adjust VAT Due from the menu. Choose the VAT Agency and one VAT item to 
populate the total in the VAT Payable account. The adjustment account would be the Share Capital 
Account. The screen capture below shows an opening adjustment to VAT Payable. 

  



Module 2 Getting Your Client Started: Setting Up and Customising Data Files 

78 

ADJUSTING PAYROLL LIABILITIES 
Assuming QuickBooks will be used for payroll payments, each employee will require proper detailed 
setup, including personal information, wages, compensation, and statutory pay information. In 
addition, because the Start Date will be in the middle of a payroll year, payroll year-to-date totals 
(wages, company contributions, deductions and so on) must be entered for each employee so that 
their year-end payroll forms will have correct totals. 

Furthermore, the payroll liabilities account must be adjusted for the various types of payroll liabilities 
owing as of the Start Date. This must be done by adjusting the payroll liabilities for the company as a 
whole and for each employee, in addition to including Payroll Liabilities in the general journal entry 
that affects the Share Capital Account. 

To adjust the payroll liabilities account as of the Start Date, select Employees > Payroll Taxes and 
Liabilities > Adjust Payroll Liabilities. For all company payroll items, select the radio button next to 
Company. For all employee payroll items, select the radio button next to Employee and choose the 
employee from the drop-down list. For each adjustment, choose the Start Date as the Date and the 
Effective Date and enter the payroll item and the amount of the adjustment. Select Accounts 
Affected… and choose Do not affect accounts since the total amount of the Payroll Liabilities has 
been entered in the general journal entry affecting Share Capital Account. 

 

Ensure that you have the correct detail to all payroll liabilities as of the Start Date by running the 
Payroll Liability Balances report. Access this report by selecting Reports > Employees & Payroll > 
Payroll Liability Balances from the menu. This will ensure that when the time comes to pay payroll 
liabilities, the correct liability items and amounts will show as ready to be paid. 

ESTABLISHING OPENING STOCK BALANCES 
If the company uses the stock features of QuickBooks, the recorded quantities and values will need to 
be adjusted to actual quantities and values as of the Start Date. This should be done by establishing 
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the quantities on hand and valuation when creating the Stock Part, as shown in the following screen 
capture. 

  

Following the steps outlined above will ensure that all opening balance information has been entered 
correctly. You are now ready to complete the setup process and verify the accuracy of the company 
file setup.  
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CLEARING THE SHARE CAPITAL ACCOUNT 
Print a Trial Balance as of the Start Date and confirm the balances of all accounts except Retained 
Earnings. Make any adjustments necessary using the procedures laid out above. If you entered any 
partial year income and expenses, these balances will be automatically closed to Retained Earnings 
on the day after the Start Date — the first day of the new financial year. Note the balance of the Share 
Capital Account. 

Once you have verified the account balances, create a journal entry to close the balance of Share 
Capital Account to Retained Earnings. (If the company is a sole proprietorship Share Capital Account 
will be closed to the Owner’s Equity account. If the company is a partnership, the balance will be 
closed to the individual partner’s equity accounts.) From the menu, select Company > Make General 
Journal Entries… Now enter the journal entry that closes the balance of Share Capital Account to 
Retained Earnings, as shown in the screen capture below. 
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APPENDIX E: VERIFYING THE COMPANY 
FILE SETUP 

After you have closed the Share Capital Account, verify the accuracy of the Balance Sheet by 
completing the following procedures: 

1. Print a Balance Sheet dated the first day of the new financial year – the day after the Start 
Date. The account balances should match those on the source Trial Balance. 

2. If you created the company in mid-year, print a year-to-date Profit & Loss Report and make 
sure that the amounts agree with your source documents. 

3. Print the Customer Balance Detail report and tie the Accounts Receivable subsidiary ledger 
to your source documents. 

4. Print the Supplier Balance Detail report and tie the Accounts Payable subsidiary ledger to 
your source documents. 

5. Print the Stock Valuation Detail report and tie the Stock quantities on hand to your physical 
stock. 
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APPENDIX F: COMPLETING THE SETUP PROCESS 

Now that setup is essentially complete, there are a few remaining tasks to wrap-up the process: 

1. Back up the newly created company file. From the menu, select File > Create Backup and 
follow the prompts. 

2. Set the Closing Date and enter a Closing Date Password. This setting can be accessed from 
the menu by selecting Edit >Preferences > Accounting > Company Preferences or 
Company > Set Closing Date.  
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APPENDIX G: ADVANCED TECHNIQUES 
TO SAVE TIME 

USE AN EXISTING COMPANY FILE TO CREATE THE NEW COMPANY 
FILE MAINTAIN A LIBRARY OF TEMPLATE COMPANY FILES 
For those who routinely create new QuickBooks data files, consider creating a library of template or 
skeleton companies (without any transactions or balances) from which to draw when creating a new 
date file. Then, whenever a company new file needs to be created, use one of these predefined files 
as the template and use a few simple Windows commands to recycle these files to be used to create 
new QuickBooks data files.  

To use an existing company file to create a new company file, perform the following steps. 

1. Select an appropriate template or skeleton company file upon which to base the new 
company. 

2. Using Windows Explorer, Copy, Paste, and Rename the company file to the new company 
file name. 

3. Now open the newly-named company file. From the menu, select Company > Company 
Information and enter the correct information for the new company. 

The new data file will contain everything the template file contained, including the Chart of Accounts 
List, Preferences, Customised Reports, and Customised Form Templates (although the templates will 
have to be edited to incorporate company-specific graphics such as company logos and other 
details).  

4. All that remains is to enter beginning balances (as of the Start Date) for the trial balance and 
outstanding bank, customer, and supplier transactions along with stock items, and the file is 
ready for use. 

The template files could be industry-specific. For instance, template data files could be created for 
medical practices, construction companies, professional firms, and other industries often served. The 
total amount of setup time involved in creating a new data file will be much less than if the EasyStep 
Interview process were utilised for each new company file to be created in QuickBooks. 
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IMPORT DATA FROM OTHER COMPANIES TO EXPEDITE SETUP 
PRECAUTIONS: After you create the QuickBooks data file, there will hopefully be some name lists 
to import, so that you do not have to enter list names (such as items, accounts, customers) 
manually one at a time. It is prudent to perform a distinctly-named backup before you do any new 
importing or entering of balances into your new data file so that you can restore from the backup 
in case you make a mistake. Best practice is to have an historical trail of backups (i.e. 
"generations" of backups) so that you can go back to almost any version of the data file you are 
building. For example, a backup prior to importing items and quantities on hand might be named 
CompanyFilePriorToItemAndQOHImport.QBB. 

IIF files 
Almost all list information in QuickBooks may be exported from one company file and imported into 
another. The export/import process utilises Intuit Interchange Format (IIF) files as the means for 
transferring information. These are tab-delimited text files which may be opened in Notepad, or 
preferably in Excel. To export lists from an existing company file, open the company and select File > 
Utilities > Export > Lists to IIF files… Select the lists to export from the dialogue box shown below, 
and click OK. 

 

To import a list that has already been exported, open the company into which you desire to import the 
list. From the menu, select File > Utilities > Import > IIF Files… and then select the IIF file to be 
imported. 
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Excel Import 
In addition to importing IIF files, QuickBooks can also import four types of lists from Excel. The lists 
that can be imported from Excel are the Chart of Accounts List, Customer List, Supplier List, and Item 
List.  

1. To begin this process, select File > Utilities > Import > Excel Files…from the menu and 
then select Advanced Import.  
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2. Select the workbook and worksheet to be imported, define an appropriate mapping scheme, 
and then import the data directly from Excel. The following dialogue box displays the setup for 
importing new customers. 
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3. A formatted spreadsheet is then provided for you to copy columns from an existing Excel 
spreadsheet and paste them for import into QuickBooks by selecting Add My Data Now. 

 


